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Having problems accessing the Internet or submitting your data? 

Call us:  1800 677 027 Email us:   grantsanddata.help@dest.gov.au 
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1. REGISTERING FOR SSP 
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What is Registration? 

Registration is the process whereby: 

• You identify yourself; 

• You identify the School or system that you represent; 

• You request access to the SSP applications you need to use; 

• Your registration details are checked in the SSP System; and 

• You are sent a logon and password for SSP via email that will allow you to logon to SSP. 

Who can Register to use the SES application in SSP? 

Registration is limited to: 

• staff members who will be processing the school’s student addresses; and 

• approved signatories of the Approved Authority for your school or system 

If you already use other applications within SSP (Financial Questionnaire, Financial Accountability, 

Census on the Internet), then you are already registered as a SSP user and you should not

attempt to register again.  Instead, please refer to the Help Section on Requesting Additional 

Access in SSP.  Please note, however, that if you want additional access and you already have 

access in respect of more than one school or system, you won’t be able to use the Request 

Additional Access facility.  Please contact the HelpDesk on 1800 677 027 or ssp@dest.gov.au to 

arrange access.  

How to Register 

To register, you must fill in the Online Registration Form. 

You can find the online registration form by clicking on the ‘register’ button located in the top left 

corner of SSP’s logon page (see diagram below). 

For information on filling out the Online Registration Form, please refer to the Help Section (‘Filling 

out the Online Registration Form’).

If you are attempting to re-register because you have forgotten your Logon ID and/or Password, 

please refer to the Help Sections (‘Forgot Your Logon?’ or ‘Forgot your Password?’) for information 

on how to be reminded of your password or your logon. 
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The Registration Process 

The registration process involves several steps. 

Step 1 – Register for Access to SSP 

The first step of registration involves you, or someone on your behalf, going to the online 

registration page and entering your personal details into the Online Registration Form.  This 

information will be used to create your user account and to determine what type of access you 

require.  SSP will guide you through the process and will return appropriate messages.  These 

messages will be displayed at the top of the online registration form when you click on the ‘Save 

Registration’ button located at the bottom of the screen. 

SSP will then check to see if you are already a registered user.  If you are, it will advise you to use 

SSP’s ‘Forgotten your Logon’ facility. 

If you are a new SSP user, a new user account will be created.  SSP will send you an email 

confirming that the registration process was successful and advise you of your logon ID. 

Step 2 – Validation of Your Request 

All new registrations are validated by SSP Security Administrators.  When a new registration 

request has been received, DEST may contact your school or system to confirm the registration 

request.

Step 3 – Approval or Rejection of Your Request 

If your registration is approved, SSP will send you an email advising you that your registration 

request has been approved and will provide you with a password.  

If rejected, SSP will send you an email advising you that your request was rejected.  In this 

instance, you should contact the HelpDesk on 1800 677 027 or ssp@dest.gov.au.

Once you have received a password, you can log on to SSP to access the services you requested.  

For more information on logging on to SSP, refer to the Help Section, ‘Logging On to SSP for the 

First Time’.
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2.  WORKING THROUGH THE SES WEBSITE 
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access SES website 
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“view school”

create

upload

file

file upload – 

multiple addresses 

(“upload”) 

manual data 

entry – individual 

address      

(“data entry”) 

“submit 

addresses”

“replace all 

addresses”

check progress of 

address submission 

upload file to 

DEST database 
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submit individual 
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submit

another
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submission

complete
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edit
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print
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add
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submit statutory 

declaration   

(“stat dec”) 

certify addresses 

submitted to DEST are 

complete and correct    

(tick box) 

Guide to using the SES Website for address submission 
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Sign On to SSP 

• The address for the Schools Service Point (SSP) portal is 

https://schools.dest.gov.au/SSP/

• Full Screen (F11) recommended 

• Hyperlinks eg   or click here appear throughout the SES website 

• Security – Logons and Passwords are unique and are issued to individual schools and 

Systems by DEST (see Section 1) 

• Change Password recommended  
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Select the SES Funding Application 

• School Systems and multi-campus schools will be able to access all their schools and 

campuses

• Please keep a record of the time spent preparing and submitting address data.  A 

Time Box is available at the end of the process 

• The text only version of the website is faster to download and can be used if your 

connection is slow 
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Welcome Page 

• School identified by client number and name in top left corner

• Selected Quadrennium shown in top right corner

• Options for working with data;

o 2001-04 Funding Quadrennium (view address data only, no changes) 

o 2005-08 Funding Quadrennium 

o 2009-12 Funding Quadrennium

• Note:   Information provided through this site is given and received in confidence
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View School 

• View School page provides an overview of the selected client in SES  

• View System page provides an overview of the system 

• School / system identified by client number and name 

• Options available: 

o Upload 

o Data Entry 

o View Addresses 

o SRN Search 

o Statutory Declaration 

o Help 
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View School – Multiple Campuses or System 

• View School page provides an overview of the selected client in SES  

• View System page provides an overview of the system 

• School / system identified by client number and name 

• Options available to Head School or System: 

o Select Head School or Campus 

o Return to Head School or System 
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Upload Student Addresses 

• Submitting a file containing multiple addresses

• Accessed from View School or left side bar 

• Transfer file to DEST:

o Step 1 – type the path and name of the file to be submitted or use the 

 feature

o Step 2 - 
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Upload Student Addresses – Part 2 

• Part 2 of the address Upload process 

• Notifies that the file has arrived at DEST 

• When file arrives at DEST you may submit your file to the database by selecting 

• If you have previously submitted an address file successfully to the DEST database, 

you may replace all your previously submitted addresses by selecting 

(Note:  This will delete all of your previously submitted addresses) 
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Upload Student Addresses – Feedback Successful 

• Part 3 of File Transfer (Feedback Successful) 

• Notifies that the file transfer has been successful 

• Options available: 

o Submit another address file using the ‘upload’ function 

o Add, edit or delete single addresses using the ‘data entry’ function 

o Complete the submission with a Statutory Declaration by selecting the 

‘stat dec’ function 
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Upload Student Addresses – Feedback Unsuccessful 

• Part 3 of File Transfer (Feedback Unsuccessful) 

• Notifies that the file transfer has been unsuccessful 

• Notifies you of the error responsible for the unsuccessful transfer 

• There may be more errors than the initial one identified.  It is essential that you consult 

the Field Names and Specifications to determine the cause of the error (see page 42).

If there are multiple errors, select the ‘Download Errors’ link to download a file 

containing a description of all errors 

• Amend the error(s) in your address data on the Excel spreadsheet 

• Save again as comma or tab delimited text file 

• Resubmit amended file through the File Transfer Process by selecting the 

 option on the Upload Student Addresses page
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Upload Student Addresses – Feedback Successful but with Queries 

• Part 3 of File Transfer (Feedback Successful, but with Queries) 

• Notifies that the file has been successfully added to the database (or has successfully 

replaced all addresses previously submitted) 

• Notifies the number of submitted addresses after transfer 

• Queries with your data are identified, eg 

o Postcode may be incorrect; or 

o No street or lot number is attached to a Street Name 

• These queries should be checked and, if necessary, corrected, before moving to the  

View Student Addresses page or completing the data submission process with a 

Statutory Declaration 



 17

Data Entry Page 

• Add or edit individual addresses  

• Accessed from View School or the left side bar 

• All mandatory fields ( * )must be entered for successful submission of addresses to the 

database

• Interactive messages occur if mandatory fields are not completed  

• Additional rules also apply – if a street name is provided, then a House Number or Lot,

Section, Portion or RMB Number are also mandatory 

• You must click on  after each address for it to be added to the DEST 

database
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Data Entry – Address with Queries 

• Data Entry page for entering, editing or deleting individual addresses  

• Accessed from View School, left side bar , SRN Search Page or View 

Addresses Page 

•  highlights the field with a query 

• Addresses with queries can be changed before re-submitting 
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SRN Search Page 

• Search for the address of a particular student 

• Accessed from the left side bar  

• To search for a student address enter the student SRN 

• When entered, click 

Having problems accessing the Internet or submitting your data? 

Call us:  1800 677 027 Email us:   grantsanddata.help@dest.gov.au 
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View Student Addresses Page 

• View all addresses submitted to DEST 

• Accessed by selecting  from the left side bar 

o  highlights addresses with queries 

• By clicking on the SRN (hyperlinked) for the student address you can view, edit or 

delete the address as it is linked to the Data Entry Page 

• You can download the student addresses by selecting the  link 

• You can also print the addresses shown on the screen by selecting File and Print from 

the menu bar of the browser 

o Before printing your report make sure you have chosen LANDSCAPE 

orientation for your paper in Page Set Up 
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Statutory Declaration – Step 1 

• A Statutory Declaration is required to complete the data submission process 

• Accessed from the link on the View School page  or the left side bar

when there are no queries associated with any of the addresses submitted 

• To continue the Stat Dec process, click on the  button 
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Statutory Declaration – Select a Signatory – Step 2 

• Accessed from Step 1 of the Statutory Declaration process 

• Select an authorised person from the list.  Please note that the names of authorised 

persons listed on this page have been approved by DEST 

• If the names listed on this page are not up-to-date, an updated Approved Authority 

form, signed by the current Approved Signatory, must be attached to the Statutory 

Declaration that you post to DEST.

• The Approved Authority form can be accessed by selecting the 

link

• To complete the Stat Dec process, click on the  button
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Statutory Declaration – Step 3 

• Accessed from the ‘Statutory Declaration – Select a Signatory’ step of the Statutory 

Declaration process 

• The authorised person signing the Statutory Declaration is declaring that all three 

requirements have been met 

• To access the Statutory Declaration, the certification box  must be ticked.  This 

certifies that the data collection process is complete and correct and that a Privacy 

Notice has been provided to the parent or caregiver of each student for whom a 

residential address has been submitted 

• To complete the Statutory Declaration form, click on the  button 

• Please record an estimate of the time taken by all your staff to complete the data 

collection process.  Include in your estimate, the time spent reading instructions, 

obtaining information, collecting, submitting and finalising your data submission.
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Statutory Declaration Form 

• The Statutory Declaration can only be accessed when you certify  that your address 

data submission is complete and correct.  Scroll down to view the entire form 

• The Statutory Declaration will be identified by your school / system DEST Number  

• The address of your school will also appear  

• When certified, the number of addresses submitted (including unusual circumstances) 

and the date and time will be shown

• You must POST the original signed Statutory Declaration to DEST 

(LCN 1M1, GPO Box 9880, CANBERRA  ACT 2601) 
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View School Page – ‘Locked’ 

• When the Statutory Declaration has been submitted, the data are locked and restricted 

to viewing only 

• Locking the data prevents any further changes to addresses and ensures the integrity 

of the Statutory Declaration 

• If you wish to have your data unlocked for further editing, please send an email (link 

provided on the ‘Welcome Page’) to DEST 

• In this event, another Statutory Declaration will need to be completed and posted to 

DEST
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Having problems accessing the Internet or submitting your data? 

Call us:  1800 677 027 Email us:   grantsanddata.help@dest.gov.au 
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3.  PREPARING YOUR STUDENT ADDRESS 

RECORDS IF USING EXCEL 

The data in Excel need to be formatted in a particular way for the DEST SES Website to 

be able to read it and store it correctly. By having the data in the correct format, it will 

enable the information to be submitted successfully to this site.   The table on page 45 

provides an example of how address data may look in a spreadsheet programme such as 

Microsoft Excel. 

Figure 1 is an example of how your data may currently be displayed in Excel. 

Figure 1 

Selecting Columns 

Being able to select columns or rows allows for quick formatting, deleting or moving of 

data.

To select a column: 

1. Move the mouse onto the column heading to be selected 

2. Click on the mouse 

(The whole column will become selected, see Figure 2)

Figure 2 
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Inserting Columns 

It may be necessary to insert extra columns to allow for the way the data will be broken up. 

It is suggested that an extra five columns be inserted for the break up of the address. 

To insert extra columns: 

1. Select the column to the right of where the new column will be positioned 

(For example if column D is selected, a new column D will be created and the original 

column D will become column E) 

2. Choose the Insert menu, then Columns

(See Figure 3)

3. Continue this process until enough columns are inserted 

(See Figure 4)

TIP:  If more than one column is selected when inserting columns, the number of columns 

selected will be inserted. 

Figure 3 

Figure 4 
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Converting Text to Columns 

If the address is in one column, it can be split into separate columns by using a feature 

called Text to Columns. 

To convert text to columns: 

1. Select the column to be converted

(See Figure 5) 

2. Choose the Data menu, then Text to Columns

(See Figure 6)

3. Click on the Delimited option 

(See Figure 7)

4. Choose Next

5. Click in the box next to the Space Delimiter 

(See Figure 8)

6. Choose Next

7. Observe how the data changes, choose Finish

(See Figure 9) 

Figure 5 

Figure 6 
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Figure 7 

Figure 8 
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Figure 9 

Best Fitting Data 

Some of the columns may not be wide enough to display all of the data in the column. The 

columns can be best fitted to display the widest piece of information. 

To best fit the columns: 

1. Select the column(s)

2. Rest the mouse on the on the right hand side of the selected column heading(s). (A 

double headed arrow appears) 

3. Double click

(All of the data in the columns is now visible, see Figure 10)

Figure 10 
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Deleting Rows and Columns 

The data may contain column headings, such as name and address. This row will need to 

be removed as will any extra rows or columns.

It is preferable to delete all column headings before saving. 

To delete a row or column: 

1. Select the column or row

2. Choose the Edit menu, then Delete

(See Figure 11)

Figure 11 

Any data that is in the incorrect column will then need to be moved to the correct position. 

In Figure 12 below, notice that the second record, which is invalid because it contains a 

PO Box number, has been corrected and replaced with the street number and address. 

The student names have been deleted and several other pieces of information have been 

included, such as the DEST number.  

(See Figure 12)

Figure 12 
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Saving the Data in the Correct Format 

The spreadsheet needs to be saved as a tab delimited file or a comma delimited file. 

To Save the Excel data in the correct format: 

1. Choose the File menu, then Save As

2. Click on the drop down arrow next to Save in to navigate to the correct drive and 

folder

3. Click on the drop down arrow next to Save as type

4. Choose txt (tab delimited) or csv (comma delimited)

5. Type in a name

(See Figure 13) 

6. Choose Save

Figure 13 
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Opening the Data in Notepad 

Once the data has been formatted as txt or csv, it can then be opened in Notepad if you 

wish to view the data. 

To open the data in Notepad: 

1. Open Notepad

2. From the File menu, choose Open

3. Click on the drop down arrow next to Look in to navigate to the correct drive and 

folder

4. Click on the drop down arrow next to Files of type and choose All files

(See Figure 14) 

5. Select the file

6. Choose Open

Figure 14 

Displaying the Data in Notepad

Figure 15 shows how the data looks when saved as a csv file. 

NOTE:  The extra commas in Figure 15 depict the fields that do not contain information. 

Do not delete them as it will put the remaining information into the incorrect fields. 

Figure 15 
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4.  HANDY HINTS 

Internet Browser

The Internet browser is the software used to view the SES Website.  To open it you can 

either double click on the ‘Internet’ Icon on your desktop; or go through your Start menu. 

Browsers Supported 

The minimum browser versions supported in the Schools Service Point (SSP) are: 

• Microsoft Internet Explorer v5.01 and above; 

• Netscape v7.0 and above; and 

• Safari 2.01. 

DEST recommends that you use the most recent browser version your equipment will 

support and that schools seek independent advice about the loading of new browsers.

DEST takes no responsibility for the impact of new browsers on the school’s computing 

environment.
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Access to SES Website 

The SES Website can be accessed through the Schools Service Point portal: 

https://schools.dest.gov.au/SSP/

The first screen you will see when you access the site is: 
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SES Website

When you select the SES Funding application the Welcome Page will appear with a series 

of hyperlinked buttons on the left side bar menu.  Where these take you is explained 

below.

Sign On Page  

Allows you to navigate back to the Schools Service 

Point Homepage 

Allows you to navigate to the SES Welcome Page 

Allows you to select a quadrennium to work with 

(Note:  The 2001-2004 quadrennium is restricted to 

viewing only, if data is available) 

Available to systems and multicampus schools.

Allows you to select a school or campus to work with 

Provides you with contact details for the Schools 

Grants and Data Section, for example the Schools 

Grants and Data Help Desk, Facsimile, Email and 

Post details 

Provides you with on-line help and useful information 

about the SES funding arrangements, including all 

publicly released documents 

Provides you with a copy of the SES Privacy Notice 

which must be sent to all parents / legal guardians of 

eligible students attending your school/s at the time of 

the address submission 

Allows you to log off and end your session in SES or 

SSP

The text only option allows you to view pages without 

downloading images 

Takes you to the Department’s homepage 

Provides you with DEST’s website Privacy Statement 

(Note:  this is not the Privacy Notice that must be sent 

to all parents / legal guardians of eligible students 

attending your school/s at the time of the address 

submission)

Provides contact details for General Recurrent Grants 

Funding, for example the Schools Grants and Data 

Help Desk, Facsimile, Email and Post details 
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SES Website Welcome Page 

When you Sign On, the Welcome Page will appear.  From this page you will be able to 

access the student residential addresses and SES scores used to calculate your school’s 

SES score for the 2001-2004 or 2005-2008 funding quadrennium, and submit student 

residential addresses that will be used by DEST to calculate your school’s SES score for 

the 2009-2012 funding quadrennium: 
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View School Page 

Once you have selected a funding quadrennium to work with, a series of hyperlinked 

buttons will be available on the side bar menu.  Where these menu options take you is 

explained below. 

View School Page Buttons  

Will return you to the SSP Home Page 

Will return you to the SES Home Page 

Allows you to access an overview of your school or 

system details relevant to SES 

Will allow you to submit a file(s) containing multiple 

addresses to DEST by file upload 

Will allow you to manually enter addresses one at a 

time to the DEST database 

Will allow you to complete the data collection 

Will allow you to search for the address of a particular 

student by their Student Record Number (SRN) 

Allows you to view all addresses submitted for the 

currently selected school or campus 

Will allow you to find out more about the online 

facilities accessible through the SES Website  

Will return you to the SSP Logon page 

An additional hyperlinked button will appear if you Logon as a Head Campus or as a 

School System. 

Will allow a Head Campus or School System to select 

and view data for individual schools or campuses 



 40

 Hints and Tips 

• Full Screen feature of the browser (F11) recommended for viewing SES Website 

• The Toolbar should always be displayed 

• Screen resolution – 800 x 600 pixels – is recommended 

• If you notice colour changes or white patches, minimise then maximise window or scroll 

down and back 

• Window size – use maximised 

• Use  mode which provides faster performance for users with a slow 

internet connection 

Do’s

• Use the mouse to scroll up and down and to select buttons 

• Use the keyboard to enter data 

• Printing reports – click in the part of the screen you want to print then click on the 

printer icon in the toolbar of the browser 

• Always log off and shut down the browser 

• Preferably use higher speed modem 

• Read all message windows carefully 

Don’ts

• Disclose your Sign On or Password to unauthorised personnel 

• Use Back and Forward icons on your toolbar 

• Use non-Frame supported browsers 

• Hide Toolbar of your browser 

Troubleshooting

• You can’t get started 

o Check your Internet connection and browser are working 

o Check your platform and browser version 

• Internet connection failure or Internet connection busy 

o Wait 2-3 minutes until message disappears, or shut down browser and retry 

• You lose the buttons on the left hand side 

o Minimise then maximise the window to restore 

• You selected SESHelp but the page did not come up 

o Some features, such as SES Info and Help, open in a second window.  Minimise 

the current window to view the second window 

Having problems accessing the Internet or submitting your data? 

Call us:  1800 677 027 Email us:   grantsanddata.help@dest.gov.au 
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5.  FORMATTING AND FIELD SPECIFICATIONS 

FOR THE STUDENT ADDRESSES
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